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Overview 
Stellar Password Recovery for Outlook is a complete solution to recover lost and forgotten password of 

email accounts of Microsoft Outlook.  

You can recover password of PST files by using Stellar Password Recovery for Outlook. All valid 

passwords will be generated by Stellar Password Recovery for Outlook that can be used to open PST 

files. However, the exact password will not be generated but a series of password will be available to 

open PST file. You can use any of the password generated by Stellar Password Recovery for Outlook 

to open PST files. 

What's New in this Version? 

• New and enhanced GUI. 

• Supports MS Outlook 2016. 

• Supports drag and drop of selected files. 

Key features: 

• Recovers lost or forgotten password of Microsoft Outlook PST files. 

• Supports MS Outlook 2000, 2002, (XP), 2003, 2007, 2010, 2013, 2016 



 

Installation Procedure 
Before installing the software, ensure that your system meets the minimum system requirements. 

Minimum System Requirements 

• Processor: Pentium 

• Operating System: Windows 10 / Windows 8.1 / Windows 8 / Windows 7 / Windows Vista 

• Memory: 1 GB 

• Hard Disk: 50 MB of free space 

• MS Outlook: 2016 / 2013 / 2010 / 2007 / 2003 

To install the software: 

• Double-click StellarPasswordRecoveryforOutlook.exe executable file to start installation. 

Setup - Stellar Password Recovery for Outlook dialog box is displayed. 

• Click Next. License Agreement dialog box is displayed. 

• Choose I accept the agreement option. Next button will be enabled. Click Next. Select 
Destination Location dialog box is displayed. 

• Click Browse to select the destination path where the setup files will be stored. Click Next. Select 

Start Menu Folder  dialog box is displayed. 

• Click Next. Select Additional Tasks dialog box is displayed. 

• Select check boxes as per your choice. Click Next. Ready to Install dialog box is displayed. 

• Review your selections. Click Back if you want to change them. Click Install to start installation. 

The Installing window shows the installation process. 

• After completing the process, Completing the Stellar Password Recovery for Outlook Setup 

Wizard window is displayed. Click Finish. 

Note: Clear Launch Stellar Password Recovery for Outlook check box to prevent the software from 

launching automatically. 

  



Launching the Software 
To launch Stellar Password Recovery for Outlook in Windows 10: 

• Click Start icon -> All apps -> Stellar Password Recovery for Outlook  -> Stellar Password 
Recovery for Outlook Or, 

• Double click Stellar Password Recovery for Outlook icon on the desktop. Or, 

• Click Stellar Password Recovery for Outlook tile on the home screen. 

To launch Stellar Password Recovery for Outlook in Windows  8.1 / 8: 

• Click Stellar Password Recovery for Outlook tile on the home screen. Or, 

• Double click Stellar Password Recovery for Outlook icon on the desktop. Or, 

To launch Stellar Password Recovery for Outlook in Windows 7 / Vista: 

• Click Start -> Programs -> Stellar Password Recovery for Outlook -> Stellar Password 
Recovery for Outlook. Or, 

• Double click Stellar Password Recovery for Outlook icon on the desktop. Or, 

• Click Stellar Password Recovery for Outlook icon in Quick Launch. 



 

User Interface 
Stellar Password Recovery for Outlook software has a very easy to use Graphical User Interface.  

After launching the program, you will see the main user interface as shown below: 

 

The user interface contains menus and buttons that let you access various features of the software with 

ease. 

  



Menus 
Home Menu 

 

 

Home 

Use this option to go to the home page of the 

software. 

Add PST 

Use this option to add the PST files for which you 

want to recover the password. 

Find PST 

Use this option to search PST files from the 

system. 

Find Password 

Use this option to start the password recovery 

process. 

Stop 

Use this option to stop the password recovery 

process. 

Activation Menu 

 

 

Activate 

Use this option to activate the software after 

purchasing. 

 

Support Menu 

 Update Wizard 

Use this option to check for both, latest minor 



 

 

and major versions available online. 

Purchase 

Use this option to Stellar Password Recovery 
for Outlook. 

Support 

Use this option view the support page of 

stellarinfo.com 

Enquiry 

Use this option to submit enquiry to 

stellarinfo.com 

Help Menu 

 

 

Help 

Use this option to view the help manual for the 

software. 

Knowledgebase 

Use this option to visit Knowledgebase articles 

of stellarinfo.com 

About 

Use this option to read  information about the 

software. 

Style Menu 

 
 

Style 
 

Use this option to switch between various themes for the 

software, as per your choice. 
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Buttons 

 
 

 

Click this button to go to the Home page of the software. 

 
 

 

Click this button to add the PST files for which you want to recover the 

password. 

 
 

 

Click this button to search PST files from the system. 

 
 

Click this button to start the password recovery process. 

 
 

 

Click this button to stop the password recovery process. 

 
 

 

Click this button to activate the software after purchasing. 

 
 

 

Click this button to check for both, latest minor and major versions available 

online. 

 
 

 

Click this button to buy Stellar Password Recovery for Outlook software. 



 

 
 

 

Click this button to view the support page of stellarinfo.com. 

 
 

 

Click this button to submit enquiry to stellarinfo.com. 

 
 

 

Click this button to view the help manual for the software. 

 
 

 

Click this button to visit Knowledgebase articles of stellarinfo.com. 

 
 

 

Click this button to read information about the software. 

 
  



Ordering the Software 
To know more about Stellar Password Recovery for Outlook, click here. 

To purchase the software online, please visit https://www.stellarinfo.com/email-repair/outlook-
password/buy-now.php 

Alternatively, click on Purchase icon in Support Menu on Menu Bar to purchase the software online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required 
to activate the software. 

  

https://www.stellarinfo.com/password-recovery/outlook-password-recovery.php
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Activating the Software 
The demo version is just for evaluation purpose and must be eventually activated to use the full 

functionality of the software. The software can be activated using the Activation Key which you will 

receive via email after purchasing the software.  

To activate the software: 

1. Run demo version of the software. 

2. On Activation menu, click Activate option. Activate window is displayed as shown below. 

 

3. Choose ’I don’t have the activation key’ (Use this option if you have not purchased the product) or 

select ’I have the activation key’ (Use this option if you have already purchased the product). 

To activate the software, when you do not have a activation key, follow the steps given below: 

1. In the Activate window, select 'I don't have the activation key' option. Click OK, to go online and 

purchase the product. 

2. Once the order is confirmed, a Activation Key will be sent to the email provided at the time of 

purchase.  

3. In the Online Activation window, type the Activation Key and click Activate button (Please 

ensure that you have an active Internet connection). 



 

4. ' Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK.  

To activate the software, when you have a key, follow the steps given below: 

1. In the Activate window, select 'I have the activation key' option. 

2. You can choose either 'Online Activation' (Use this option to activate the software over Internet) 

or 'Offline Activation’ (Use this option to activate the software manually / through e-mail if for any 

reason, Internet connection is unavailable). 

• Online Activation 

Online Activation is possible only when an active Internet connection is available. 

o To activate the software online: 

1. From the Activate window, select Online Activation. Click OK.  

 

2. An Online Activation dialog box will appear. 



 

3. Type the Activation Key (received through email after purchasing the product) in the 

field of Activation Key. Click Activate. 

 

4. The software would automatically communicate with the license server to verify the 

entered key. If the key you entered is valid, software will be activated successfully. 

• Offline Activation 

Offline Activation enables you to activate the product when your computer does not have an 

Internet connection. 

o To activate the software offline: 

1. From the Activate window, select Offline Activation. Click OK.  

 

2. An Offline Activattion dialog box will appear displaying Activation ID in its respective 

field. 



 

3. To get your License Key, which is required to activate the software manually, you need to 

mail the listed Activationtion ID to support@stellarinfo.com. 

4. A License Key will be sent to your email address after verifying the Activation ID and 

purchase details by Stellar Technical Support. 

5. After receiving the License Key, open Stellar Password Recovery for Outlook. In 

Activate window, select 'I have the activation key'. 

6. Select Offline Activation and click OK. 

7. Enter the License Key received through email in the field of License Key.  

 

8. Click Activate to activate the software. A confirmation message is displayed if a valid key is 

entered. Click OK. 
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Updating the Software 
Stellar releases periodical software updates for Stellar Password Recovery for Outlook software. You 

can update the software to keep it up-to-date. These updates can add a new functionality, feature, 

service, or any other information that can improve the software. Update option of the application is 

capable of checking for latest updates. This will check for both latest minor and major versions available 

online. You can easily download minor version through the update wizard. However, the major version, if 

available, has to be purchased. While updating the software, it’s recommended to close all the running 

programs. Note that demo version of the software cannot be updated.  

To update Stellar Password Recovery for Outlook: 

1. Go to Support option in Menu Bar. Click Update.  

2. Stellar Update Wizard window will open. Click Next. The wizard will search for latest updates, 

and if it finds any new updates, a window will pop up indicating its availability. 

3. Click Next and the software will download the files from the update server. When the process is 

complete, the software will upgrade to the latest version. 

Live Update may not happen due to following reasons: 

• Internet connection failure 

• Updates are not available 

Note:  If a major version is available, you need to purchase the software in order to upgrade it. 

  



Stellar Support 
Our Technical Support professionals will give solutions for all your queries related to Stellar products. 

You can either call us or go online to our support section at http://www.stellarinfo.com/support/ 

For price details and to place the order, click https://www.stellarinfo.com/email-repair/outlook-

password/buy-now.php 

Chat Live with an Online technician at http://www.stellarinfo.com/ 

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

Send e-mail to Stellar Support at support@stellarinfo.com 

Support Helpline 

Monday to Friday [ 24 Hours a day ] 

USA (Toll free Pre Sales Queries) +1-877-778-6087 

USA (Post Sales Queries) +1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280-149-899 

Netherlands Pre & Post Sales Support +31-208-111-188 

Worldwide +91-124-432-6777 

   Email Orders    orders@stellarinfo.com 
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 Add PST File 
 
Stellar Password Recovery for Outlook allows you to select PST files from your computer for the 

password recovery process. 

To add PST file: 

• Run Stellar Password Recovery for Outlook. 

 

• From the Home menu, click Add PST button. An Open dialog box will appear. Browse and select 

the desired file and then click Open. 

Or, 

Drag and drop the desired file to the application. 

Or, 

Click Drag & Drop to add PST button on the main user interface. An Open dialog box will appear. 

Browse and select the desired file and then click Open. 



Find PST Files 
 
Stellar Password Recovery for Outlook allows you to find PST files in your computer's hard drive, in 

case you don't know their location. With the help of 'Find PST' option, you can find PST files in any folder, 

subfolder or an entire volume in your system. 

To Find a PST File: 

1. Run Stellar Password Recovery for Outlook application. 

2. From the Home menu, click Find PST. 

3. In Browse for Folder dialog box, select the drive you want to search for PST files. Click OK. 

4. After the search is finished, a list of PST files found in the selected drive is shown. 

5. Select files for which you wish to recover the password and click Find Password button to 

proceed to the password recovery process. 



 

  

Find Password 
You can recover password of any PST file by using Stellar Password Recovery for Outlook. All valid 

passwords will be generated by the software that can be used to open PST files. You can use any of the 

generated passwords to open your PST file. 

To recover password of PST file: 

1. Run Stellar Password Recovery for Outlook. 

2. Select the PST file whose password you wish to recover or if you don't know the location of your 

PST file you can use Find PST option to search for PST files. A list of all the available PST files 

will be displayed from which you can select your desired file for the password recovery process. 

3. Click Find Password. 

 

4. A series of passwords will be generated which can be used to open your PST file. 



 

Note: Exact password will not be generated but all valid passwords will be available to open PST file. 

  



 

Import PST File 
To import PST file in Microsoft Outlook 2016 / 2013: 

• Open Microsoft Outlook. From File Menu, select Open & Export.  

• Select Import / Export option from the right pane. 

• From Import and Export Wizard window, select Import from another program or file, click Next. 

• In Import a File dialog box, select Outlook Data File (.pst), click Next.  

• Click Browse to locate the PST file that needs to be imported. In the options box, select an 
appropriate option. Click Next. 

• In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft 
Outlook. Click Finish. 

To import PST file in Microsoft Outlook 2010: 

• Open Microsoft Outlook. From File Menu, select Open -> Import. (For MS Outlook 2013, select 
Open and Import from File Menu) 

• From Import and Export Wizard window, select Import from another program or file, click Next. 

• In Import a File dialog box, select Outlook Data File (.pst), click Next.  

• Click Browse to locate the PST file that needs to be imported. In the options box, select an 
appropriate option. Click Next. 

• In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft 
Outlook. Click Finish. 

To import PST file in Microsoft Outlook 2007 / 2003: 

• Open Microsoft Outlook. From File menu, select Import and Export. 

• From Import and Export Wizard window, select Import from another program or file, click Next. 

• In Import a File dialog box, select Personal Folder File (PST), click Next. 

• Click Browse to locate the PST file that needs to be imported. In the options box, select an 
appropriate option. Click Next. 

• In Import Personal Folders dialog box, select the folders that should be imported in Microsoft 
Outlook. Click Finish. 

  



 

FAQ's 

1. I have forgotten the path of my PST file. Can this application search it for me? 

Yes, the application can look for PST file on your system and find it for you easily. There is a 

dedicated Find PST option in the application through which you can locate a particular PST and 

run password recovery on it. 

2. What version of outlook is supported by the software ? 

The software Supports PST Files made by MS Outlook 2016, 2013, 2010, 2007, 2003, 2002 

(XP), and 2000. 

3. How Can I Recover Password of a PST file ? 

Please follow the below procedure to recover the password. 

• Open the Stellar Password Recovery for Outlook software 

• Click Add PST button. 

• Navigate to the file, select it and click Open. 

• Click Find Password to recover the passwords. 

Software will show the password of the PST file. 

4. Does this software recover original password for the PST files? 

No, the application does not recover the exact password but will generate all valid password to 

open the PST file. 

  



 

Legal Notices 

Copyright 

Stellar Password Recovery for Outlook software, accompanied user manual and documentation are 
copyright of Stellar Information Technology Private Limited with all rights reserved. Under the copyright 
laws, this user manual cannot be reproduced in any form without the prior written permission of Stellar 
Information Technology Private Limited. No Patent Liability is assumed, however, with respect to the use 
of the information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights 
reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 
REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 
EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 
ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 
INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 
INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 
OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 
THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 
BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 
WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 
WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 
THEREOF. 

Trademarks 

Stellar Password Recovery for Outlook® is a registered trademark of Stellar Information Technology 
Private Limited. 

Windows Vista®, Windows 7®, Windows 8®, Windows 8.1®, Windows 10® are registered trademarks of 
Microsoft® Corporation Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective 
companies. 

 

 

 

 

 

 



License Agreement - Stellar Password Recovery for 
Outlook 
Stellar Password Recovery for Outlook 

Copyright © Stellar Information Technology Private Limited. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Password Recovery for Outlook. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar Password Recovery for Outlook with which this License is included, you may 

return the complete package unused without requesting an activation key within 30 days after purchase 

for a full refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar Password Recovery for Outlook. For purposes of this License, if you have a valid single-user 

license, you have the right to use a single Licensed Copy of Stellar Password Recovery for Outlook. If 

you or your organization has a valid multi-user license, then you or your organization has the right to use 

up to a number of Licensed Copies of Stellar Password Recovery for Outlook equal to the number of 

copies indicated in the documents issued by Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar Password Recovery for Outlook may either be used by a single person 

or used non-simultaneously by multiple people who use the software personally installed on a single 

workstation. This is not a concurrent use license. 

All rights of any kind in Stellar Password Recovery for Outlook, which are not expressly granted in this 

license, are entirely and exclusively reserved to and by Stellar Information Technology Private Limited. 

You shall not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative 

works based on Stellar Password Recovery for Outlook nor permit anyone else to do so. You shall not 

http://www.stellarinfo.com/


 

make access to Stellar Password Recovery for Outlook available to others in connection with a service 

bureau, application service provider or similar business nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Stellar Password Recovery for Outlook and all accompanying software, files, data and materials are 

distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. You 

acknowledge that good data processing procedure dictates that any program including Stellar Password 
Recovery for Outlook must be thoroughly tested with non-critical data before there is any reliance on it 

and you hereby assume the entire risk of all use of the copies of Stellar Password Recovery for 
Outlook covered by this License. This disclaimer of warranty constitutes an essential part of this License. 

In addition, in no event does Stellar authorize you or anyone else to use Stellar Password Recovery for 
Outlook in applications or systems where its failure to perform can reasonably be expected to result in a 

significant physical injury or in loss of life. Any such use is entirely at your own risk and you would not 

hold Stellar responsible for any and all claims or losses relating to such unauthorized use. 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 

violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

  



 

About Stellar 
Stellar Data Recovery is a global leader in providing data recovery, data migration and data erasure 

solutions for the past two decades. Stellar Data Recovery is a customer centric, critically acclaimed, 

global data recovery, data migration & erasure solutions provider with cost effective solutions available for 

large corporates, SMEs & Home Users. Stellar Data Recovery is headquartered in New Delhi, India and 

has a strong presence across USA, Europe & Asia. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

Email Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of Email. 

More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

Data Erasure 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/file-repair/file-repair-software.php
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/prevent-dataloss.htm


 

Stellar Data Erasure software under the brand BitRaser help businesses & consumers permanently 

erase confidential data beyond the scope of data recovery.  You can perform high speed bulk data 

erasure & generate erasure certificates for audit trail purpose. BitRaser supports 24 International data 

erasure standards. More Info >> 

For more information about us, please visit www.stellarinfo.com 

 

http://www.stellarinfo.com/data-erasure/data-eraser-windows.php
http://www.stellarinfo.com/
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